PREPARING FIGURES TO REPRESENT GENDER EQUITY BENCHMARK DATA

<table>
<thead>
<tr>
<th>Figure Type</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bubble Charts</td>
<td>2 - 5</td>
</tr>
<tr>
<td>Time in Rank Box Plots</td>
<td>6 - 10</td>
</tr>
<tr>
<td>Flux Charts</td>
<td>11 - 13</td>
</tr>
</tbody>
</table>
Creating Bubble Charts in MS Excel

1. Open the Benchmarks spreadsheet in MS Excel. At the bottom of the window you will see all the worksheet tabs. Select the tab named **HR-IR 2** by clicking on it with the left button of your mouse.

2. Select the **Insert** option from the excel menu (at the top of the window) and then select **Worksheet**. A blank sheet should appear, it will probably be called **Sheet 1**. Right click with your mouse on the worksheet tab of this new sheet and select **Rename** (the sheet name will then be highlighted). Type **HR-IR 2chart** as the new name for the sheet.

3. Enter the numbers 1 through 8 in the first row and eight 1’s in the second row so that your worksheet looks something like this:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4. Select the **Insert** option from the Excel and then select **Chart…** and a window entitled **Chart Wizard – Step 1 of 4 – Chart Type** will appear.

5. Under the Standard Types tab, you should see a list of chart types including one called **Bubble**. Select this option by clicking on it with the left button of your mouse, then under Chart sub-type: choose the option on the left

6. Select **Next >** to go to **Chart Wizard – Step 2 of 4 – Chart Source Data**.

7. The Data Range tab should be blank (if something is shown there delete it). Select the Series tab and then select the **Add** button in the lower left - four options will appear on the right after you do this. Leave the Name: option blank but fill the rest in as follows:

   Click in the empty box next to **X Values:** and then select the numbers 1 through 8 in row 1 of your **HR-IR 2chart** worksheet. What shows up in the box should be:

   \[ =HR-IR\ 2chart!$A$1:$H$1 \]

   Click in the box next to **Y Values:**; delete whatever is in the box and then select the eight 1’s in the second row of your **HR-IR 2chart** worksheet. What shows up in the box should be:

   \[ =HR-IR\ 2chart!$A$2:$H$2 \]

   Click in the box next to **Sizes:**; delete whatever is in the box and then select the row of the total of professors in each rank for Natural Sciences on the **HR-IR 2** worksheet (the bottom row of numbers shown here).

<table>
<thead>
<tr>
<th>Natural Sciences</th>
<th>Women</th>
<th></th>
<th>Men</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Assistant</td>
<td>Associate</td>
<td>Full</td>
<td>Assistant</td>
</tr>
<tr>
<td>Biological Sciences</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chemistry</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer Science</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mathematics and Statistics</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Physics and Astronomy</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>All Natural Sciences</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Women</th>
<th></th>
<th>Men</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Assistant</td>
<td>0</td>
<td>3</td>
<td>4</td>
<td>2</td>
</tr>
<tr>
<td>Associate</td>
<td>1</td>
<td>1</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Full</td>
<td>0</td>
<td>0</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Assistant</td>
<td>0</td>
<td>1</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>Associate</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Full</td>
<td>1</td>
<td>6</td>
<td>13</td>
<td>9</td>
</tr>
</tbody>
</table>
What shows up in the box should be something similar to: =HR-IR 2!F$13:$K$13 (this may vary depending on the current HR-IR 2 worksheet)

8. Select Next > to go to Chart Wizard – Step 3 of 4 – Chart Options.

9. Select the Titles tab and make sure all the options are blank, then select the Axes tab and remove the check (if there is one) from both the Value (X) Axes and the Value (Y) Axes boxes. Remove any existing checks from the Gridlines and Legend tabs as well. Finally, on the Data Labels tab add a check next to the Bubble size box.

10. Select Next > to go to Chart Wizard – Step 43 of 4 – Chart Location.

11. Choose to place chart As object in: HR-IR 2chart then select Finish.

12. Double click on the gray area of the chart, a window should appear where you can select the border and area colors. Select none for both options and then OK.

13. Double click on the edge of the largest circle and a window should appear with a tab called Options. Select this tab and change Scale bubble size to: 75% and then OK.

14. Double click on the numbers then go to the Alignment tab in the window that appears. Under Label Position: select center and then OK.

**Inserting and Editing the Bubble Chart in MS PowerPoint**

1. Save (but don’t close) the Excel spreadsheet and open MS Power Point. Delete anything which appears on the PowerPoint slide by holding down the left button of your mouse to make a window around the objects and then select the Delete on your keyboard.

2. In Excel, put the cursor on the edge of the chart, click the right button of your mouse and select Copy. Once you have copied the chart you can close Excel if you wish.

3. In PowerPoint, go to Edit on the menu at the top of the window, then select Paste Special… and a window will appear. Select Picture (Enhanced Metafile) and then OK. The graph should then appear on the PowerPoint slide. If you do not insert the chart in this way, you will not be able to edit it properly in PowerPoint.

4. The chart will probably be somewhat small at this point, so you may want to make it bigger. To do this double click on the chart and a window called Format Picture will open. Select the Size tab. Under Scale, change both Height: and Width: to 200% and then select OK. If the picture extends beyond the slide boundaries, select the picture and hold down the left button of your mouse as you drag it back to the center of the slide.

5. If you do not see the Drawing toolbar on your screen, right click on one of the other PowerPoint toolbars (or on the top menu bar), and left click on Drawing.

6. Make sure the chart is highlighted (when the chart is highlighted small circles should show at the corners and mid points of each edge) and select Draw from the Drawing menu and then select Ungroup. A warning message will appear, click on Yes (you do want to convert the picture to a Microsoft Office drawing object).

7. While the object is still highlighted, go to Draw and select Ungroup again. Every element should now appear as a different object.
8. Select the large rectangle and delete it. You will probably have to do this several times because there will be a number of rectangles on top of each other.

9. Make a window around all the text (it doesn’t matter if some circles are selected as well) and change the font to Arial, 14 point, Bold.

10. Select all the circles that represent women professors (if you hold down the shift key you can add or subtract objects from your selection), right click on the selected objects and then select Format AutoShape… In the resulting window, select the Colors and Lines tab and change the Fill Color to white, the Line Color to black and the Line Weight to 1.5 pt.

11. Repeat step 10 for the male professors, but change the Fill Color to light grey.

12. Select an individual circle and the text that goes inside it then go to the Draw menu and select Align or Distribute then Align Center, then repeat the same process but select Align Middle (instead of Center).

13. Group each circle with the text that goes inside it, by selecting Group from the Draw menu (while both objects are highlighted).

14. Repeat steps 12 and 13 for each set of circles with text.

15. Open the CUPS chart from the previous year and copy all but the circles with the text in them (make sure to Ungroup all the objects before copying them). Paste them into the new slide you have created.

16. Move your circles horizontally using the arrow buttons on your keyboard. Group the circles in one row together before moving them vertically.
Examples of Gender Equity Benchmark Bubble Charts

2003-2004 Hunter College Science Professoriate

Number of Professors in Natural Sciences by Rank and Sex

<table>
<thead>
<tr>
<th>Rank</th>
<th>Female</th>
<th>Male</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assistant</td>
<td>4</td>
<td>9</td>
<td>13</td>
</tr>
<tr>
<td>Associate</td>
<td>5</td>
<td>15</td>
<td>20</td>
</tr>
<tr>
<td>Full</td>
<td>12</td>
<td></td>
<td>33</td>
</tr>
<tr>
<td>Distinguished</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>

Number of Professors in Social Sciences by Rank and Sex

<table>
<thead>
<tr>
<th>Rank</th>
<th>Female</th>
<th>Male</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assistant</td>
<td>15</td>
<td>14</td>
<td>29</td>
</tr>
<tr>
<td>Associate</td>
<td>14</td>
<td>14</td>
<td>28</td>
</tr>
<tr>
<td>Full</td>
<td>12</td>
<td></td>
<td>32</td>
</tr>
<tr>
<td>Distinguished</td>
<td>3</td>
<td>1</td>
<td>4</td>
</tr>
</tbody>
</table>

Data Source: City University Personnel System (CUPS) database, Department of Human Resources, Hunter College, 30 June 2004

1997-2004 Hunter College New Science Hires

Number of New Hires in Natural Sciences by Sex

<table>
<thead>
<tr>
<th>Female</th>
<th>Male</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>14</td>
</tr>
</tbody>
</table>

Number of New Hires in Social Sciences by Sex

<table>
<thead>
<tr>
<th>Female</th>
<th>Male</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>26</td>
</tr>
</tbody>
</table>

Data Source: City University Personnel System (CUPS) database, Department of Human Resources, Hunter College, 30 June 2004
Creating Time in Rank Box Plots in SPSS

1. Open the Time in Rank database in SPSS.
2. Create a string (text) variable for the time period breakdown by:
   a. Select Transform form the menu at the top of the screen and select Recode and pick Into Different Variables…
   b. Highlight the Degree Year [degyr] variable on the left and then press the ► arrow to move into the Input Variable -> Output Variable box
   c. In the area to the right of the window called Output variable, for Name: type in yrpd and for Label: enter Time year period then select the Change button on the right.
   d. Select the Old and New Values… button
   e. Under Old Value at the left side of the window, select Range: option and type in the first and last year of the time period (i.e. 1980 through 1989).
   f. Put a check in the box on the lower right which says Output variables are strings, then under New Value (in the upper right area of the window), for Value: type in the time period (i.e. '80-'89).
   g. Select the Add button under Old - - > New (for the example described here 1980 thru 1989 - -> “’80-’89” appears on the right.
   h. Repeat steps e through g for all the time periods then select Continue and the OK.
3. Select Graphs form the menu at the top of the screen and select Interactive and pick Boxplot…
4. On the Assign Variables tab, select the desired Time in Rank variable (i.e. Time in Rank Full [tirfull]) and holding the left button down drag this variable in the space provided on the vertical arrow (y-axis) on the right. Select the variable you created (Time year period [yrpd]) and drag and drop it on the horizontal arrow on the right (x-axis). Finally, under Legend Variables marked Color: drag and drop the Sex[sex] variable to the space provided then proceed to step 5.
5. Go to the Boxes tab. Make sure there are checks next to Outliers, Extremes and Median Line. Under Whisker Caps select the option all the way to the left (it looks like a plain T) then proceed to step 6.
6. Go to the Options tab. Under Categorical Order select the arrow in the space next to Variable: and select Time year period from the list. Under Sort: uncheck the box next to Exclude empty categories and then select OK button at the bottom left area of the window.
7. Double click on the box plot and an editing window will open. Double click in the blank area directly above the box plot and a Chart Manager window should appear.
8. Highlight Scale Axis on the left side of the window and then select Edit… on the right side of the window.
9. On the Scale tab, uncheck the 4 boxes all the way to the right under Auto. Then change Minimum: to 0, Maximum: to 35, Tick Interval: to 5, and Number of Ticks: to 8. Go to the Labels tab and change the number next to Decimals: to 0 then select OK.

10. Highlight Color Legend on the left side of the window and then select Hide on the right side of the window. Close the Chart Manager window by clicking on the X at the upper right corner of the window. Get out of the editing window by clicking anywhere in the area outside the window.

11. Repeat steps 3 through 10 for all the rank levels (assistant, associate and full).

12. Save the Output and the Data files with an appropriate name and location (i.e. similar name and same location as the original data file).

**Inserting and Editing the Box Plots in MS PowerPoint**

1. Open MS Power Point. Delete anything which appears on the PowerPoint slide by holding down the left button of your mouse to make a window around the objects (if you miss an object, you can hold down the shift key to add or subtract items from the selection) and then select the Delete on your keyboard.

2. In the SPSS output file, put the cursor on the box plot, click the right button of your mouse and select Copy.

3. In PowerPoint, go to Edit on the menu at the top of the window, then select Paste Special… and a window will appear. Select Picture (Enhanced Metafile) and then OK. The box plot should then appear on the PowerPoint slide. If you do not insert the box plot in this way, you will not be able to edit it properly in PowerPoint.

4. If you do not see the Draw toolbar on your screen, right click on one of the other PowerPoint toolbars (or on the top menu bar), and left click on Drawing.

5. Make sure the box plot is highlighted (when an object is highlighted small circles should show at the corners and mid points of each edge) and select Draw from the Drawing menu and then select Ungroup. A warning message will appear, click on Yes (you do want to convert the picture to a Microsoft Office drawing object).

6. While the object is still highlighted, go to Draw and select Ungroup again. Every element should now appear as a different object.

7. Delete all the objects (except for the ticks at the bottom) outside the rectangle around the box plots and delete the colored boxes of the box plot. You should start with something like the picture on the left below and end up with something like the picture on the right:
8. Select all of the remaining objects and go to the Draw toolbar and select Group.

9. Double click on the group of objects and a Format Object window should open. On the Colors and Lines tab, select black for the line color and .75 pt for the line weight and then select OK.

10. Ungroup the objects and select the 1st and 3rd box by holding the shift key and selecting each box individually. Go to Format on the main menu at the top of your screen and the go to AutoShape… On the Colors and Lines tab, go to fill color and select red, then under line color select No Line, and then select OK.

11. Select the 2nd and 4th boxes and repeat step 10 but change the fill color to light blue instead of red.

12. Select the median lines by holding down the shift key as you make windows around them using the left button of your mouse. Go to Format on the main menu at the top of your screen and the go to AutoShape… On the Colors and Lines tab, select 2.25 pt for the line weight and then select OK.

13. Select any outliers then go to Format on the main menu at the top of your screen and the go to AutoShape… On the Colors and Lines tab, under line color select No Line and then select OK. Your box plots should now look similar to the picture below:
14. Group all of the objects together.

15. Select the group and go to Format on the main menu at the top of your screen and go to Object... On the Size tab, change the Height: to 2.77" and the Width: to 2.54" (make sure there is not a check next to the Lock Aspect Ratio box in the middle of the window).

16. Go to Insert on the main menu at the top of your screen and select New Slide.

17. Repeat steps 2 through 16 for the box plots of the other ranks.

18. Open the PowerPoint file with the Time in Rank box plots from the previous year and copy all but the box plots (make sure to Ungroup all the objects before copying them). Paste these objects into the newest blank slide you have created. The objects you are copying should look something like this:

![Box Plot Diagram]

Note: Median years in rank includes the time spent in rank for all current faculty as of 30 June 2003. N indicates the number of 2002-2003 science faculty members from that degree range who have ever held that particular rank, (n) indicates the number of faculty members in that rank on 30 June 2003.

Data Source: City University Personnel System (CUPS) database, Department of Human Resources, Hunter College

19. Copy and paste the box plots you created on the other slides onto the slide shown above. Be careful to place the box plots in the correct place (i.e. know which of the plots you made is for Assistant professor and make sure it is in that space on this slide).
Example of Time in Rank Box Plots

Hunter College – 2003-2004 Academic Year: Time in Rank for STEM Faculty in Social Sciences by Sex and Year of PhD

Note: Median years in rank includes the time spent in rank for all current faculty as of 30 June 2003. N indicates the number of 2002-2003 science faculty members from that degree range who have ever held that particular rank, (n) indicates the number of faculty members in that rank on 30 June 2003.

Data Source: City University Personnel System (CUPS) database, Department of Human Resources, Hunter College
Creating Flux Charts in MS PowerPoint

**Note:** Examples refer to the sample flux chart on page 13

1. On a blank slide, insert a chart
   a. Enter data into the datasheet. Time should be represented by columns and professorial rank by lines.
      - Enter data for time period 1 (e.g., Spring 1999) should be entered into column B and data for time 2 (e.g., Spring 2004) is indicated in column D. Leave data columns A, and C blank to create space on the chart for explanatory text.
      - Data for assistant professors should be entered on line 1; data for associate professors on line 2, and data for full professors on line 3
      - Your datasheet should look something like this:

        |   | A | B | C | D |
        |---|---|---|---|---|
        |   |   | Spring 1999 | Spring 2004 |
        | 1 | Assistant | 21 | 42 |
        | 2 | Associate | 42 | 48 |
        | 3 | Full | 108 | 94 |

   b. The chart should be formatted using the following settings:
      - Chart Type = Column, stacked column
      - Clear gridlines
      - To show the number of faculty at each rank displayed at the top of each bar as indicated in the example flux chart, you will have to use a text box.
        - The y axis should be formatted so that
          - the category type is General (use the Number tab on the Axis format menu)
          - the minimum and maximum values make sense for your data
        - The x axis should be formatted so that there are no major or minor tick marks
   c. All other information on the slide is entered via text boxes or by using the draw function to draw lines or arrows.
      - Use the draw function to draw straight lines between the two bars so that the lines of demarcation between the ranks extends between the bars.

2. **Faculty who left** during the specified time period are represented by left-pointing arrows (i.e., \(\leftarrow\)) originating in the time 1 bar (e.g., Spring 1999). Distinctions are made between those who resigned, retired, and left for administrative positions.

3. **Newly hired faculty** are represented by left-pointing arrows (i.e., \(\leftarrow\)) originating to the right of the time 2 bar (e.g., Spring 2004) and extending through the time 2 bar into the space between the two bars.
4. **Faculty who were promoted** during the specified time period are represented by upward-pointing arrows (i.e., ↑) between the two bars. The arrows start in the area representing the original rank (e.g., assistant professor) and extend into the space representing the new rank (e.g., associate professor).

5. **The percentage that left** each rank during the time period represented by the chart is indicated to the left of the time 1 bar (e.g., in the example flux chart, 13% of assistant professors, 8% of associate professors, and 20% of full professors left between Spring 1999 and Spring 2004).
   - **To calculate the percentage that left at each rank:**
     \[
     \text{% left} = 100 \times \frac{\text{# at that rank who left during the specified time period}}{\text{# at that rank at time 1} + \text{# new hires at that rank} + \text{# promoted to that rank}}
     \]
     Example calculations:
     a) 13% assistant professors left = 100 * (1 retired + 7 resigned/ (21 assistant professors during Spring 1999 + 42 new assistant professor hires + 0 promoted to assistant)
     b) 8% associate professors left = 100* (2 retired + 3 resigned / (42 associate professors during Spring 1999 + 5 new associate professor hires + 13 people promoted from assistant to associate professor)

6. **The percentage promoted** at each rank during the time period represented by the chart is indicated to the right of the time 2 bar (e.g., in the example flux chart, 21% of assistant professors and 12% of associate professors were promoted between Spring 1999 and Spring 2004).
   - **To calculate the percentage promoted at each rank:**
     \[
     \text{% promoted} = 100 \times \frac{\text{# at starting rank who were promoted during the specified time period}}{\text{# at starting rank at time 1} + \text{# new hires at starting rank} + \text{# promoted to starting rank}}
     \]
     Example calculations:
     a) 21% of assistant professors were promoted to associate = 100* (13 assistant professors promoted to associate/ (21 assistant professors during Spring 1999 + 42 new assistant professor hires + 0 people promoted to assistant)
     b) 12% of associate professors were promoted to full = 100* (7 associate professors promoted to full/ (42 associate professors during Spring 1999 + 5 new associate professor hires + 13 people promoted from assistant to associate professor)
Sample Faculty Flux Chart

Faculty Flux* at Hunter College
Total natural and social science faculty, 1999 - 2004

Note: To examine gender differences, two flux charts should be constructed, one for female faculty and one for male faculty.